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Introductory Examples

This  documentation  is  intended  to  help  you  get  started  with  editing  beam  and  shell  structures  and  to  demonstrate  the
various options available for displaying the results. You can press the F1 key to access the online help for the function you
are currently using in the program. The help system also contains the complete documentation of the program, including
explanations of theoretical principles, calculation methods and results.

During  installation  example  files  will  be  saved  to  the  user  directory  under  InfoGraph/Samples.  They  include  projects  with
beam,  cable  and  shell  structures  as  well  as  applications  relating  to  structural  dynamics  and  prestressed  concrete
construction.

The examples are provided without results. To view the results, you first need to perform the relevant calculation. Product
news, user tips and updated versions of the program are available at www.infograph.eu.

InfoCAD Study Version
The  InfoCAD  Study  Version  was  created  as  a  way  to  get  acquainted  with  the  program  and  its  features  by  using  the
examples or your own projects.

The study version provides the same user interface, calculation and checking methods and results output as the full version.
The only difference lies in the program capacity, which is limited as follows:

Finite elements: 1000 elements

1 area section

1 beam section

Dynamics: 1 eigenmode

Prestressing: 1 tendon

Frameworks: 10 beams

1 section

Installation

The program is compatible with Windows 8 or higher. Administrator privileges are required to perform the installation. Only
basic user privileges are needed to use the program.

For installation, start the installation file infocad_xxx.exe or infocad_std_xxx.exe for the study version.

In the welcome dialog that appears,  select the menu item Install  InfoCAD  and follow the instructions  on the screen.  You
have already received the license number to be entered by e-mail and also used it for the download. This is not required for
the study version.
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The following applications will be installed and can be launched from the Start menu

1. InfoCAD or InfoCAD Study Version
(main program system for static calculations and checks)

2. InfoGraph Systemviewer
(for system visualization and deformation animation)

3. InfoGraph Crack Width Limitation
(stand-alone program)

4. InfoGraph Lateral Torsional Buckling Check
(stand-alone program)

To remove the program system, select the Apps menu in the Windows Settings. There, the automatic uninstall program for
InfoCAD can be started. All files created or modified by the user are retained.

General Instructions

Program Start

To start  the  program,  go  to  the  Programs  /  InfoGraph  folder  in  the  Start  menu  and  select  InfoCAD  or  InfoCAD Study
Version. An empty program window will appear.

Click the  Open button to access InfoGraph project files with the following extensions (e.g., example files):

File name .fem

.rsw

.esw

.ros

->

->

->

->

Finite Element Project

3D Frame

2D Frame

Axisymmetric shell

These file types are registered during installation, which means they can be opened by simply double-clicking the file.
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Operating Concept

The figure below highlights the most important controls of the InfoCAD program interface. For FEM projects, the xy plane
appears in the representation area after you select the structure type. Slab and plain stress structures are generally specified
in this plane.

Functions  can  be  accessed  from  a  tool  bar,  a  menu  item,  the  dialog  bar  or  the  workspace.  For  graphical  functions  you
normally have to enter additional data, which is then queried in either a separate window or the dialog bar.

Design Codes

The design codes and associated materials available in the program correspond to the regional settings of your computer. If
necessary, you can change these settings in the Options menu.
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Basic Procedures

Structures are normally specified and calculated using the following work steps:

1. Describe the problem with the model objects

2. Specify supports and cross-sections

3. Generate an element mesh

4. Define load cases

5. Define the actions and design situations

6. Perform calculations

7. Display or print out the results

Model objects are critically important for system generation

Model  objects  describe  the  geometry  and  properties  of  individual  structural  components.  They  form  the  basis  for  the
program-controlled  generation  of  finite  element  meshes  and  are  accounted  for  the  automatic  mesh  generators  form-
sensitive and grid-shaped.

The following model objects are used:

Edge Edges define the borders and the axes of structural components. Depending on their properties, they can
also define a line support, a beam series or free beams (e.g. columns). Edges are normally used to
describe the whole structure in a wire frame model.

Wall Like edges, walls define the border of a structural component as well as a line support. The geometry of a
component is determined by the wall axes. Walls are specifically suited for creating pure slab systems.

Hole Holes define openings in the element mesh. They can also define line supports and continuous beams
according to their properties.

Column Columns define a point support or, alternatively, a column head condensation in the element mesh.

Face Faces describe areas that are automatically meshed by the mesh generator. Edges, walls and holes form
the outer border of these meshes. All model objects inside the face are taken into consideration during
mesh generation. The face can be assigned various properties for the FEM mesh.

Cone The Cone model object describes a truncated cone segment for subsequent meshing. You can use the
shortcut menu to determine the degree of intersection with other selected cones or model faces. A cone
can also be assigned various properties for the FE mesh.

Solid The model object Solid describes a solid body for the subsequent mesh generation with tetrahedron
elements. Properties for the FE mesh can be assigned to the solid.

Model objects have no further significance once the element mesh is generated. However, they should be saved as drawings
for reuse at a later time.

For an area to be meshed, a closed polygon must be defined using edges and/or walls. If you want to mesh multiple areas
in different planes at the same time, then model faces should be defined as well.
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Selecting

If you want to edit or delete an object, you first need to select it. This can be done in a number of different ways:

1. Select individual objects via mouse click. You can expand or reduce the selection by holding down the Shift or Ctrl key
while clicking the objects.

2. Select an area by holding down the mouse button and dragging the cursor. When you let go of the mouse button, all
objects completely inside the drawn rectangle will be selected.

Selecting with the right mouse button, the shortcut menu with the standard commands for the selected objects
will appear.

3. The Select command in the Edit menu allows consecutive additions/deletions of the selection using selection boxes for
example.

4. The Select group... command in the Edit menu allows you to select objects based on shared properties such as color,
layer or section.

5. The Select All command in the Edit menu.

All  of  these  selection  methods  can be  combined  with  one  another.  Selections  are  removed when you  click  on an  empty
space in the workspace.

You can access the shortcut menu for objects  that  are already selected by holding down the Shift  or  Ctrl  key
and pressing the right mouse button.

Entering Coordinates

You can enter coordinates with either the keyboard or the crosshair.

If you are using the keyboard, enter the x, y and then z coordinates separated by a space in the dialog bar. The measures are
always meter [m]. The positive direction corresponds to the displayed coordinate system.

For 2D editing you only need to enter the first two coordinates. The program will automatically set the third coordinate to
zero. The decimal separator (e.g., on the numeric keypad) conforms with the one defined in the regional settings.

Global coordinates These coordinates always refer to the global zero point.

 Relative coordinates Die These coordinates refer to the last point that was entered (local zero point). A small
axis system is always visible at this point. To activate relative coordinate input, click the 
Relative button.
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Using the crosshair to enter coordinates, it automatically refers to an existing object.

The current snap option will be displayed.

   

   

   

The Node, Midpoint, Intersection, Endpoint, Perpendicular and Object snap functions can be used to define the
snap mode and ignore the automatic snap function. Click the appropriate button to activate them.

The snap window will then appear in the crosshair: 

The selected snap function will remain active until it is disabled or replaced by another.

Example 1: Slab with Downstand Beam
This example shows you how to specify and calculate a basic floor plate and then process the results.
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Loads: Permanent load  Dead load and additional load 1.50 kN/m²

Traffic Area load 3 kN/m²

A new project is started when you launch the program or select New from the File menu.

Choose the Finite Elements structure type from the structure menu.
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Drawing Ground Plans with Model Objects

Ground plans and in spatial  structures wire frame models are  initially  described using the Edge,  Column and Hole  model
objects. These objects will later be recognized by the mesh generator and taken into account during mesh generation.

You do not need to make any definitions regarding the area:

Simply draw your static system. The mesh generator will take care of the rest.

   
Click the Edge button and select properties in the dialog bar.

 

For  Meaning set the option  Support  and  leave  the  dialog
with OK.

A crosshair will appear in the representation area and you will  be prompted to enter the coordinates of where the

edge starts in the dialog bar. Enter [0 0] to position the start of the edge at the origin. After you press [ ¿ ] or Enter,
the end of the edge will be queried.

 
To enter additional coordinates, you should activate relative coordinate input by clicking the Relative button. A small
axis system will now always appear at the last point inserted. All successive coordinates you enter always refer to this
point. Enter [0 2.1] to define the end of the edge in the positive y direction. If you enter consecutive coordinates, the
subsequent edge ends will always be queried. The remaining coordinates are therefore:

[-4.9 0]  [0 -6.3 ]  [4.9 0]  [0 -2.8]  [ 7 0]  [0 3.5]  [3.5 0] [0 4.2] [-4.9 0] [0 -2.1]

 

 

To temporarily enlarge the view, click Zoom - or Zoom all.
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You can begin entering another edge without having to use the command over again by selecting the Start option.
Now enter the missing edges. In the process you can click on the endpoints of existing edges.

 

 

Click  the  Column  button  and  enter  the  column  midpoint.  To  move  the  current  reference  point  for  the  entry  of
coordinates,  click  the  Basepoint  button  and  select  the  end  of  the  edges  to  the  right  of  the  column  as  the  new
reference  point.  Confirm  the  Old  or  Global  setting  (the  local  reference  system  is  not  to  be  rotated)  as  the  New
direction of x axis.

The  column  should  be  3.5 m  in  the  negative  x  direction  from  the  selected  edge  end  point,  which  means  the
coordinates for the column midpoint are: [-3.5 0].

 
One  way  to  check  your  input  is  to  dimension  the  system.  To  do  so,  click  the  Dimension  button  and  the  Objects
option. Now select all of the specified model objects. Dimension points are the end points of all objects. For example,
to position a horizontal dimension chain, select Horizontal and click the drawing area below your system.

 
Click Save to store all  the data you have entered up to this point. The Windows file dialog will appear and prompt
you to enter a file name. The *.fem extension will be assigned automatically. Your drawing will also be given a name
(E.g. Ground_plan) and is saved in this file.

Specifying Supports and Cross-Sections

The properties of the specified Edge and Column model objects are preset as follows:

Edge: Support jointed

Column: Support jointed

The correct support conditions are thus already set for this system.
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With  the  selection  of  the  material  the  possible  design
standards are determined.

The corresponding properties are now available.

For  example  the  material  C  ......  -EN-D  is  to  choose
when the checks per NA Germany are to be performed.

For the other European standards, the material selection
is C...... -EN.

To modify the properties of the area elements, select the Element Properties command. Click New and then change
the section type to Area for Section 1. The thickness is preset correctly with 0.2 m and the material must be selected
to C20/25-EN. For the next input this material is preset.

The  default  settings  for  the  remaining  section  properties  such  as  bedding,  reinforcing  steel  and  EN 1992-1-1  are
correct for this example.

Click  New  again  and  generate  Section 2.  Change  the  section  type  to  Polygon.  The  input  window  for  graphically
describing the polygon is displayed:

 
You  can  generate  and  dimension  the  polygon  shown  above  using  the  Downstand  Beam  command.  Close  the
window by clicking OK.

Activate the Reduce dead load button to decrease the dead load of the T-beam by the portion attributed to the slab.

 

Beam  series  (downstand  beams)  with  the  specified  section  should  be
generated at the two last entered edges to replace the supports.  Open
the Edge  dialog by double-clicking the edge you want to  modify.  Now
change  the  Meaning  to  Beam  series  and  select  Section 2.  You  do  not
need to specify the section at the end of the edge.
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Generate the FEM Mesh

   
The finite element mesh can be generated automatically using the specified model objects. To do so, click the Mesh
Generation  button  and  select  the  Form-sensitive  option.  Arrow indicators  will  now appear  marking the  outer  area
limits recognized by the program. Specify the mesh width (0.45 in this example) to generate the FEM mesh, supports
and beam series.

The drawing is not required anymore. Deactivate the drawing in the database .

Defining Load Cases

Open the  Load cases  folder in the database and double-click .  A new load case will  be created
automatically and the load input and editing buttons will appear in the dialog bar.

   
Click the Load creation button to open the New Load dialog:

Select Dead load with a weighting of 1 in the Z direction and then click Apply. Using this load type, the dead load will
be  generated  automatically  based on the  sections  and  material.  This  load is  indicated  by  the  Dead  Load  label  in  the
upper right corner of the image.
Now select Uniform region on the Area load tab and select two points to specify a rectangle that surrounds the entire
slab.  The  load ordinate  qz  should  correspond to  1.5 kN/m².  This  load  will  be  applied  to  all  elements  located  entirely

within the area.

 
Click Change Number to modify the load case number or to specify a load case name.

 
Create the new load case 2 using the function New load case. Select the Uniform rectangle  area load under the Load
creation  option.  The load rectangle  is  now represented by three  coordinates.  Click  on the  three  corner  points  of  the
load field. In this case the load ordinate is qz = 3 kN/m²:

Create the next load case and use the Uniform polygon area load for each remaining field. 
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Trace the next field and then click Close and enter the load ordinate qz = 3 kN/m². The program will then apply triangle

areas to the defined load area.

Now enter the depicted load cases in consecutive order, each time selecting New load case:

q
z
:3

qz:3

q
z
:3

  
Load case 3

qz:3qz:3

qz:3

  
Load case 4

q
z:

3

qz:3

q
z
:3

qz
:3

Load case 5

 
Load input is now complete. Exit the load dialog by clicking Close (in the dialog bar ).

Specifying Actions and Design Situations

When carrying out the design, first the internal forces of the actions are combined. The program uses cyclic permutation to
analyze  all  variations  of  the  leading  and  accompanying  actions.  The  safety  factors  and  combination  coefficients  are
automatically  taken  into  account  as  specified  by  EN 1990.  The  extremal  internal  forces  are  then  used  to  determine  the
design values.

This is done by simply assigning the existing load cases to the actions:

G

QN

Dead load:

Imposed load, traffic load:   

Load case 1

Load case 2-5

Open the   EN 1992-1-1   design  folder  in  the  database  and  select  the   Actions  submenu  item.  A  dialog  will  appear
where you can define actions in accordance with EN 1992-1-1. The program suggests a new G Dead load action. Confirm
by clicking OK.

Now assign the relevant load cases to the action by selecting a load case in the left pane and moving it to the Selected load
cases pane on the right:

Exit the Dead load dialog and create a new QN Imposed load, traffic load action.
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Assign the remaining traffic loads by moving them to the Inclusive load cases area.

Inclusive load cases Selected load cases that can have a simultaneous effect.

Exclusive load cases Selected load cases that are mutually exclusive
(e.g., wind from right / left or individual mobile load positions)

The action QN is now defined and you can exit the dialog.

Next  click  Situation...,  select  Permanent  and  temporary  situation  and  then  accept  the  default  settings.  The  Rare
(characteristic) situation is required to define the robustness reinforcement. Create this as well.

   

The actions and situations are now defined. You can edit  an
action or situation by double-clicking it. The user-friendly tree
structure provides an easy way of checking the included load
cases.

Click OK to exit the EN 1992-1-1 actions dialog.
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Performing Calculations

You can now perform the following calculations:

• Statics analysis (determines deformations, internal forces, support forces, etc., for each load case)

• EN 1992-1-1 design (bending and shear design)

   
The calculations can be started automatically in consecutive order. To do so, click the Batch... button and select the
relevant check boxes.

 
If necessary, you can control the calculation and logging process by clicking the Calculation settings... menu item.

The progress of the calculation and any errors or warnings will be displayed on the output bar.

Processing Results

All of the available results are listed in the  Results folder in the database. Double-click a result to open the available or
designated standard view (graphic or table) of that result.

   

 

For instance, open the Node deformations results folder and then double-click Load case 1. The deformed system will
be displayed. To see the deformation figure, switch to the 3D view.

To change the viewing angle you can use the Rotate with mouse button.
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Click the Results button in the results bar to open a dialog that lets you select the display option and settings for all
results:

 
If you select representation Section, you can click the Define section button in the results bar and define the sections
for the results view.

Please note that some view options are not available depending on the category you selected:

• A deformation figure can only be displayed for all components simultaneously and not for an individual
displacement component (e.g., uz).

• The min/max line from an internal forces combination of area elements can only be displayed numerically or in
the section.

EN 1992-1-1 Checks

In addition to the bending and shear design that has already been carried out, you can also perform additional checks in the
ultimate limit state and the serviceability limit state:

• Bending with or without normal force or normal force only (EN 1992-1-1, Chapter 6.1).

• Minimum reinforcement against failure without warning (Chapter 5.10.1 (5)P and 9.2.1.1).

• Lateral force (Kapitel 6.2).

• Torsion and combined stressing (Kapitel 6.3).

• Punching shear (Kapitel 6.4).

• Fatigue of longitudinal reinforcement, shear reinforcement and prestressing steel (Chapter 6.8.5, 6.8.6)

• Fatigue of concrete under compressive stress (Chapter 6.8.7)

• Fatigue of the concret compressive struts under lateral force and torsion (Chapter 6.8.7 (3))

• Limiting the concrete compressive stresses (EN 1992-1-1, Chapter 7.2).

• Limiting the reinforcing steel stresses (Chapter 7.2).

• Limiting the prestressing steel stresses (Chapter 7.2).

• Decompression check (Chapter 7.3.1).

• Minimum reinforcement for crack width limitation (Chapter 7.3.2).

• Crack with calculation (Chapter 7.3.4).

• Limiting deformations (Chapter 7.4).

Additional input is required in the  EN 1992-1-1 design folder for this purpose:

 Actions: Define the necessary design situation depending on the additional checks and the exposure class.
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To do this, click New: Situation... in the action dialog and create the required situations.

 

   
Settings  related  to  the  section  are  made  in  the  Element  properties  dialog.  Click  the  Element  properties  button  to
open this dialog and then enter the check specifications required for each section under EN 1992-1-1.

After you are done, start the EN 1992-1-1 design. The program will determine the required reinforcements, perform
the checks and then generate a log.

A detailed description of all the checks is available in the chapter EN 1992-1-1 Design of the InfoCAD help and the
user manual.
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Printing

   
You always have the option of printing the current screen view. Click Print Preview  to see what the actual printout
will  look  like.  The  settings  for  the  page  format,  printer  selection,  etc.,  can  be  modified  using  the  Page  Setup...
command in the File menu.

Tables  or  logs need to  be selected in the database and then printed out from the shortcut  menu (right-click).  The
Page Preview command is also available in the shortcut menu.
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Printing List

Specified  views  as  well  as  tables  and  logs  can  be  added  to  the  printing  list  for  printing  at  a  later  time.  Only  display
parameters are stored, meaning changes made to the system are automatically reflected in the list.

Switch from the database to the printing list. The Print and Page Setup commands can also be accessed in the printing list.

   
Click the Add to printing list button to copy the current system view into the printing list. All active settings will be
saved with the system view.

Use the shortcut menu to add tables or logs selected in the database to the printing list. You can also add separate
text objects, page breaks or a table of contents.

You can sort existing entries in any order you want by simply dragging them with the mouse.

Double-click entries in the printing list to open the corresponding view in the representation area.
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Example 2: 2D Hall Frame
This example shows you how to specify a 2D hall frame and perform the following calculations:

• Static calculation

• EN 1993-1-1 Steel Checks (elastic; plastic at stress exceeding in classes 1 and 2)

Please select in the menu Analysis / Settings ... EN 1993-1-1 the required national annex of the standard. This will be used in
the subsequent inputs and calculations.

Activate the Elastic; plastic at stress exceeding in classes 1 and 2 - button.

   

In  accordance  with  Chapter  6.2.1  of  the  standard,
the  elastic  cross-section  resistance  is  verified  for
classes 1 to 4.

If  the  comparison  stress  in  classes  1  and  2  exceeds
the  permissible  limit,  the  plastic  cross-section
resistance  will  be  verified.  For  every  set  of  internal
forces  the  cross-section  class  is  automatically
determined.

Task

HEA 550;S235-EN

8
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0
3
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0
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.0

0

15.00 15.00

30.00

A new project  will  be  started  when  you  launch  the  program  or  select  New  from  the  File  menu.  Choose  the  2D  Frame
structure type you want to use from the structure menu.

The representation area will switch to the x-z view and you can now start specifying the system.
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Specifying the Framework

   
Click the Element creation button and a crosshair will appear in the representation area. You will then be prompted
to enter the coordinates of the beam starting point in the dialog bar. Enter [0 0] to position the first beam node at

the global origin. Press [¿] or Enter. Next, the beam end point will be queried.

 
To enter additional coordinates, you should activate relative coordinate input by clicking the Relative button. A small
axis system will now always appear at the last point inserted. All successive coordinates you enter always refer to this
point. Enter [0 -8] to define the beam end in the negative z direction. You have now specified the first beam.

 

 

To temporarily enlarge the view, click Zoom - or Zoom all.

Enter the remaining beam ends in consecutive order and adjust the view where necessary:

[15 -3] [15 3] [0 8]

Exit beam input by pressing [¿] or Enter.

 
Now click the Supports button and choose the Create option. You will be prompted to select the beam nodes in the
dialog bar. You can click the nodes directly with the crosshair or select them using the Window option (to specify a
rectangular snap window). Press Enter after you have selected the nodes. Specify Yes when the program asks you for
the global alignment.

In the Support dialog you can individually adjust each degree of freedom if necessary.

  

Confirm that the support is set to jointed and exit the Support dialog by pressing OK. The supports are indicated by
their corresponding icons.

 
Click Save to store all  the data you have entered up to this point. The Windows file dialog will appear and prompt
you to enter a file name. The *.esw file extension will be added automatically.
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Defining the Section

   
Click  the  Element  properties  button  and  set  the  section  type  to  HEA 550  and  the  material  type  to  S235-EN  for
section 1.

 
You  also  have  access  to  a  detailed  section  library
with international steel profiles.

The complete framework is now defined and the corresponding parts list is available in the workspace in the 

 Structure description folder.

 List of steel profiles

Section Length Quanti Total Weight Weight Total
[m] ty [m] [kg/m] [kg] [t]

1 1 HEA 550 - S235-EN 8.000 2 16.000 166.420 1331.36 2.66
2 1 HEA 550 - S235-EN 15.297 2 30.594 166.420 2545.74 5.09
3 Sum 4 46.594 7.75

Checking the Structure Properties

   
You can activate a number of different view options to check the data you have entered.

To do so, click the View options button:
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Defining Load Cases

Open  the   Load  cases  folder  in  the  database  and  double-click  .  A  new  load  case  will  be  created
automatically and the load input and editing buttons will appear in the dialog bar.

   
Click the Load creation button to open the New Load dialog:

  

Activate  the  Dead  load  and  click  Apply.  Using  this  load  type,  the  dead  load
will be generated automatically based on the sections and material. This load
is indicated by the Dead Load label in the upper right corner of the image.

Now  choose  Line  load  from  the  Beam  loads  tab,  check  the  Global  orientation  option,  select  both  beams  of  the
horizontal frame member and enter a load ordinate of qz = 3.9 kN/m:

  

   
You can adjust the load diagrams in any manner you want using the Load representation button.

   
Click Change Number to modify the load case number or to specify a load case name.

Create the new load case 2 by pressing . Choose Line load from the Load creation tab, check the
Projection orientation option and enter a snow load of  qz = 5 kN/m.

5 5 5 5

Starting with New load case, enter the following load cases:

4.5

4.5

  

Load case 3: Wind from the left

4.5

4.5

Load case 4: Wind from the right
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The 'Load case 5: Crane load left' requires a single load to be positioned inside the frame column. This load should
be applied 2 meters below the frame corner. After selecting the Point load load type, simply click the corresponding
frame column and enter the ordinates as shown below:

  
1
0
0

40

For precise positioning, define a load location with a distance of 6 meters to the beam start.

Now enter 'Load case 6: Crane load right' (distance of 2 meters to beam start) 
and 'Load case 7: crane load middle' accordingly, with half the load on each frame column.

EN 1993-1-1 Steel Checks

You first need to describe the actions according to EN 1993-1-1. 
To do so, assign different actions to the existing load cases:

G Dead load: Load case 1

QS Snow and ice load: Load case 2

QW Wind load: Load case 3 and 4

QN Imposed load, traffic load:   Load case 5, 6 and 7

  

Open the  EN 1993-1-1 Steel Checks folder in the database and select

the  Actions submenu item. A dialog will appear where you can define
actions in accordance with EN 1993-1-1. The program suggests a new G
Dead load action. Confirm by clicking OK.

Now assign the relevant load cases to the action by selecting a load case
in  the  left  pane  and  moving  it  to  the  Selected  load  cases  pane  on  the
right.

Exit the Dead load dialog and create a new QN Imposed load, traffic load action.

Assign the remaining traffic loads by moving them to the Exclusive load cases area.

  

Inclusive load cases Selected load cases that can have a simultaneous effect.

Exclusive load cases Selected load cases that are mutually exclusive
(e.g., wind from right / left or individual mobile load positions)

Do the same with the QS Snow and ice load and the QW Wind load action.
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Next click Situation..., select Permanent and temporary situation and then accept the default settings.

  

The  actions  and  situations  are  now  defined.  You  can  edit  an  action  or
situation  by  double-clicking  it.  The  user-friendly  tree  structure  provides  an
easy way of checking the included load cases.

Click OK to exit the EN 1993-1-1 actions dialog.

Performing Calculations

You can now start the following calculations:

• Static analysis (determines deformations, internal forces, support forces, etc., for each load case)

• EN 1993-1-1 Steel Checks 
(superposition of actions with calculation of determinant design values, check for elastic or plastic utilizations)

In the standard case, the checks are performed at 5 calculation points per beam. Due to the overlarge element division, it is
recommended to select 11 calculation points for beams in the analysis settings for static analysis in this example.

The calculations can be started automatically in consecutive order. To do so, click the Batch...  command in the calculation
menu and activate the relevant check boxes.

The progress of the calculation and program messages, such as errors or warnings, will be displayed in the output bar.

Processing Results

  

All of the available results are listed in the 

 Results folder in the database. Double-click
a result to open the available or designated

standard view (graphic or  table) of that
result.

For instance, open the  Node deformations
folder and then double-click Load case 3. The
deformed system will be displayed.

   
Click the Results button to access various display settings.

Internal forces and comparison stresses from the 1. permanent and temporary situation:

-952.9

-9
5
2
.9

-9
5
2
.9

5
1
3
.3

-952.9

Value range (overall system, min/max): -952.91/513.35 [kNm]
Internal forces min,max My. 1043.77 [kNm] = 
LCC EN1993.SV.1: 1. Permanent and temporary situation, EN 1993-1-1

  

37.9

241.0

1
2
9
.2

241.0

37.9

Value range (overall system, min/max): 37.91/240.98 [MN/m²]
Stresses (steel checks) max Sigma.v. 263.95 [MN/m²] = 
LCC EN1993.SV.1: 1. Permanent and temporary situation, EN 1993-1-1
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You can activate the calculated utilizations in the  Stresses / Steel Checks folder. Note that the depicted frame can
only be checked if the plastic internal force limits are taken into account.

0.16

0.93

0
.5

5

0.93

0.16

Value range (overall system, min/max): 0.16/0.93 [-]
Utilization. 1.02 [-] = 
LCC EN1993.SV.1: 1. Permanent and temporary situation, EN 1993-1-1

   

In the stress view right-click any beam and select 
Section Stress from the shortcut menu.

The stresses at the section will now be applied for the
selected location.

In the depicted window you can select the results for all
load cases and combinations as well as for 

sx, sv, tx, txy and txz stresses.

The checking program records the calculation process in a concise log. You can view the log in the  Listings folder.

   

The combination information shows you the individual factors
contributing to an internal force result.

In the results view right-click the desired results location in the
beam and select Combination information from the shortcut
menu.
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Printing

   
You always have the option of printing the current screen view. Click Print Preview  to see what the actual printout
will  look  like.  The  settings  for  the  page  format,  printer  selection,  etc.,  can  be  modified  using  the  Page  Setup...
command in the File menu.

Tables or logs need to be selected in the workspace and then printed out from the shortcut menu (right-click). The
Page Preview command is also available in the shortcut menu.
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Printing List

Specified views as well as tables and logs can be added to the printing list for printing at a later time. Only references to the
specified display parameters are stored, meaning changes made to the system are automatically reflected in the list.

Switch from the database to the printing list. The printing list has its own Print and Page preview commands.

   
Click the Add to printing list button to copy the current system view into the printing list. All active settings will be
saved with the system view.

Use the shortcut menu to add tables or logs selected in the database to the printing list. You can also add separate
text objects, page breaks or a table of contents.

You can sort existing entries in any order you want by simply dragging them with the mouse.

Double-click an entry in the printing list to open the corresponding view in the representation area.

InfoGraph Systemviewer

The InfoGraph Systemviewer allows you to visualize FEM and framework projects as well as to animate deformations from
static or dynamic calculations.

Launch the Systemviewer from the Programs /  InfoGraph  folder in the Start  menu and open the file you want to view. A
variety of settings options are available to help you optimize the graphical output.
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Example 3: 3D Building
This example shows you how to specify a 3D building and perform the following calculations:

• Static calculation

• Design according to EN 1992-1-1

It is assumed that you have already gone through the previous examples. Hence, some of the processing steps will not be
detailed in this example.

Task

System axes with dimensions [m]

Material: C20/25-EN (Concrete EN 1991-1-1)

Reinforcing steel BSt 500, axis distance of 3.0 cm from edge

Load: Dead weight, area load, horizontal load

Procedure to enter 3D structures:

1. Describe a wire frame model using edges

2. Assign the wanted properties to the edges (support, beam series, free beam) 

3. Enter model faces

4. Mesh generation

Drawing the wire frame model

Launch the program or start a new project by clicking New and then selecting Finite Elements under the Structure menu.

   
Click the Edge button and begin by entering:

[0 0]

 
Activate relative coordinate input and complete the outer edge of the 1st level:

[8 0], [0 8.5], [-8 0]

Point to the start of the 1st edge to connect the lines. End the edge input with Enter or ESC.
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Select the upper edge with the right mouse button and choose Copy directly from the shortcut menu.

The program asks for the displacement vector. Select e.g.  the upper left  end of the edge to define the start point.
Now activate the option Multiple.  For the second point of the displacement vector enter  the coordinates  [0 2]  and
[0 4]. The edge will be copied 2 and 4 meters in y direction. Finish the copy process with Enter or ESC.

 
Now switch to the 3D view and create the other levels using the copy function.

To do so,  select the edges by dragging a box over all  the objects.  The selected objects  will  now be displayed with
dotted lines.

Select Copy directly in the Edit menu and specify the displacement vectors:

1. Point of displacement vector: [0  0  0]

2. Point of displacement vector: [0  0  3]

2.Point of displacement vector: [0  0  -3]

For 3D editing, always enter 3 coordinates in the order x, y and z. Based on the above coordinates, the displacement
vectors point +/- 3 meters in z direction.

 
If  you want to  temporarily  change the angle  of  view,  click  Rotate  with  mouse  and  move  the  cursor  while  holding
down the left mouse button. Click the button again to stop the rotation.

 
You can adjust the view to fit the new object dimensions using the Zoom all button.
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Enter the missing edges between the levels. It can be referred to the existing points with the snap modes mid-point,
endpoint or intersection. In this way, further manual coordinate input can be avoided.

 
Select the unnecessary edges and delete them.

To shorten  the  lower  edges  select  these  edges  with  the  right  mouse  button  and  choose  the  option  Intersect.  For
border object select the relevant edge.

     

 
In order to create supports at the columns later we use the model object Column with the option Point  at the foot
points of the columns.

The wire frame model is completed.
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Assigning Properties

Additional properties can be assigned to the edges to be taken into account while generating the mesh. Double-click one or
more edges to define the properties and set the wanted meaning:

  

Meaning Result from the mesh generator

Standard Area limitation or fixed line inside

Support Line support on the edge

Beam series Beam  elements  connected  to  the  FE
mesh, e.g. downstand beams

Free beam Beam  elements  with  independent
intersection,  e.g.  columns  or  parts  of
frames

Support +Beam series Line support and beam series

  

For  the  columns  set  Free  beam  with  pitch  = 2.  Start  the
section  dialog  and  define  the  polygon  section  with  the

function  (e.g.: Rectangle 30x60).

   Assign  the  property  Support  to  the  supported  edges  and
Beam  series  with  the  polygon  section  to  the  outer
downstand beams.

 
Click the Face button and select the Layer and Color you want to use for the element mesh before defining the area (
Properties  option).  Double-click inside the section window to open the section dialog.  Set  the properties  for the  area
section and leave the dialog.
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Now select the limiting objects for the first area. An area will be created as soon as it is fully defined by the selection.
Change the color now and again if necessary.

 
The geometric description of the system is now complete. Save the file and enter a name for the drawing.

Generating an Element Mesh

The model structure that is created serves as the basis for FEM mesh generation.

   
Click the Mesh generation button, select the Form-sensitive option and accept the suggested mesh width to 0.5 [m].

 
Click  the  View  options  button  to  access  various  settings  for  how  the  system  is  displayed.  In  the  resulting  dialog,
activate the Area fill of the elements option to improve the 3D quality of the structure.

 
Check the structure using the section representation.
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Defining Load Cases

    Open the  Load cases folder in the database and double-click . A new load case will be created
automatically and the load input and editing buttons will appear in the dialog bar.

   
For load case 1, select dead load with weighting 1 in the z direction, confirm your selection and then enter a load
case label using the Change Number button.

Click  in the database again to create the new load case 2. Select the area load Uniform rectangle
and define two rectangle area loads  on the floors.  When entering coordinates  refer  to  existing nodes  and use the
functions Zoom and Rotate with mouse.

  

For load case 3, select Line load for area elements with global orientation.
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With the Load representation option you can scale the load ordinates.

For the fourth load case create two Line loads with 2.4 kN/m and one area load with 0.8 kN/m² in global x direction.

Load input is now complete and you can exit the Load dialog.
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Describing Actions

  

Open  Actions  in the  EN 1992-1-1 Design  folder of the
database,  assign  the  following  actions  to  the  load  cases  and
create a Permanent and temporary situation.

G

QN

QW

Dead load:  

QN Imposed load, traffic load:  

Wind load:  

Load case 1 (dead
load)

Load case 2 and 3
(area load, line load)

Load case 4
(horizontal load)

Calculation and Results

   
Begin the batch calculation with the options selected as shown below.

  

The  selected  calculations  are  performed  automatically  in
consecutive  order.  You  can  follow  the  progress  of  the
calculations in the output bar.

 
Once the calculation is finished, all the results are available in the database. Open the results category you need and
select the appropriate view.

Deformations load case 1
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Colored progression of the moments max mx Support reactions Rz

Longitudinal reinforcement of the beams Lateral reinforcement of the beams and columns

InfoGraph Systemviewer

The InfoGraph Systemviewer allows you to visualize FEM and framework projects as well as to animate deformations from
static or dynamic calculations.

Launch the Systemviewer from the Programs /  InfoGraph  folder in the Start  menu and open the file you want to view. A
variety of settings options are available to help you optimize the graphical output.
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Example 4: Prestressed Roof Girder
This example involves a wide-spanned roof construction that is  represented as a continuous girder over two spans with a
double-sided cantilever. To edit this system, perform the following work steps:

• Enter a static system

• Enter a tendon group

• Enter the loads

• EN 1992-1-1 Design

• Display the results

The  structure  is  constructed  for  exposition  class  XC1.  In  accordance  with  EN 1992-1-1,  Table  7.1N  no  check  of
decompression is necessary for this exposition class.

It is assumed that you have already gone through the previous examples. Hence, some of the processing steps will not be
detailed in this example.

Task

1 17 32

16 48 48 16

128

Static system and dimensions [m]

Material

Concrete C45/55-EN

Reinforcing steel BSt 500, axis distance from edge 5 cm

Section

[cm]

370 50 370

790

2
0
6

2
4

2
3
0

Tendon groups

Four  bundled  tendons  are  arranged  in  this  example.  The  tendon  group  guide  is  shown  in  the  next  figure.  The  depicted
tendon group ordinates zv of the spline points refer to the upper edge of the section.

1 > < 1

0
0

Tendon groups in beam series Tendon view 1, [-16.00/0.00/0.00] - [112.00/0.00/0.00] / [-16.00/0.00/1.00]
Superelevation = 10

Tendon group ordinates zv [cm] at the base points

xv 0.00 6.40 12.80 19.20 25.60 32.00 38.40 44.80 51.20 57.60 64.00 70.40 76.80 83.20 89.60 96.00 102.40 108.80 115.20 121.60 128.00

1 70.0 52.0 19.2 42.0 120.2 180.1 208.8 201.5 157.4 78.3 18.5 78.3 157.4 201.5 208.8 180.1 120.2 42.0 19.2 52.0 70.0
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Prestressing steel and prestressing system

Prestressing steel quality St 1500/1770

Certification of the prestressing system EC2

Number of tendons in the bundle 4

Section surface area Az 1800 mm²

E-modulus of the prestressing steel 195000 MN/m²

0.1% strain limit (yield strength) of the prestressing steel fp0,1k 1500 MN/m²

Tensile strength of the prestressing steel fpk 1770 MN/m²

Permitted prestressing force of the tendon Pm0 2295 kN

Prestressing loss from relaxation of prestressing steel 4.5 %

Friction coefficients when increasing or releasing strain 0,2

Unintentional angle displacement of a tendon ß’ 0.3 °/m

Slippage at prestressed tie bolt 6 mm

Duct diameter 82 mm

Scattering coefficients of the internal prestressing

Construction stage (rsup / rinf ) 1.1 / 0,9

Final state (rsup / rinf ) 1.1 / 0,9

Loads

Load case 1 Dead load (G1)

Load case 2 Additional loads 11.06 kN/m (G2)

Load case 3 Snow load 7.90 kN/m (Q)

Load case 10 Prestressing (P)

Load case 15 Creep-generating continuous load: G1+P+G2

Load case 20 Creep and shrinkage (CSR)

Coefficients: jt¥ = 2.55; r = 0.8; ecs.t¥ = -24.8 · 10-5 

Creep-generating continuous load case: 15
The redistribution of internal forces between concrete and prestressing steel are taken into account.

Static System

Launch the program or start a new project by clicking New and then selecting Finite Elements from the Structure menu.

To accurately measure the prestressing and the creep and shrinkage behavior,  first  divide the structure into beams with a
length of 4 meters. Specify the supports based on a fork support of the system.

 
First switch to the xz view.

 
Click the button Element creation  and select  the element type RS Beam.  For  automatic  division activate  the option
Generate. A crosshair will appear in the representation area and you will be prompted to enter the coordinates of the

starting point in the dialog bar. Enter [0 0] to position the starting point at the origin. After you press [ ¿ ] or Enter,
the end of generation line will be queried.

 
To enter additional coordinates, you should activate relative coordinate input by clicking the Relative button. A small
axis system will now always appear at the last point inserted.

All successive coordinates you enter always refer to this point. Enter [16 0] to define the end of the generation line in
x direction.
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Enter 4 for the number of beams which shall be generated.

 

 

To temporarily enlarge the view, click Zoom - or Zoom all.

Now enter continuously the remaining section coordinates and choose the number of beams to be generated:

[48 0] - 12 Beams; [48 0] - 12 Beams; [16 0] - 4 Beams

Finish the beam input with [ ¿ ] or Enter.

 
Now click  the  Supports  button  and  choose  the  Point  support  option.  You  will  be  prompted  to  select  the  support
nodes in the dialog bar. You can click the nodes directly with the crosshair. 

During the support input take care to support the system free of restraint in the longitudinal direction and to define a
fork support.

Entering a Tendon Group

The definition of  the tendon groups does not depend on the  elements.  The  assignment  and  force  introduction  onto  the
structure occur while the Prestressing  load case is  being calculated.  To avoid  any conflicts,  a  distinction is  made between
beam and area/solid prestressing.

The  tendon  curve  on  which  the  calculation  approach  is  based  is  represented  by  a  3D  cubical  spline  function.  The  spline
function  is  the  curve  that  runs  through  all  specified  spline  points  with  the  least  amount  of  curvature.  The  basis  for  the
prestressing  analysis  is  provided  by  a  tendon  group  force  curve  that  allows  for  strain  increase,  release  and  slippage.  To
include prestressing in the FEM analysis, you need to define a load case with the Prestress load type.

 
Die Use the Prestressing function to enter and edit tendon groups.

  

Click Define and then select Beam for the tendon group type
in the resulting dialog.

Normally, the spline points are defined graphically.
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The Prestressing System tab contains all the properties that are
assigned to the tendon groups. They apply to each individual
tendon of the group.

  

If the allowance value K is used, then the factor for over-
stressing refers to the maximum permitted force Pmax.

Using the factor specified for the release, the maximum
prestressing force remaining in the tendon group is

defined with respect to Pm0. A factor of '0' means no

release.

Exit the dialog with OK and enter the spline points of the tendon group (start, supports, midspans) at the nodes of
the beam array.

When you are  done,  click Enter.  The tendon group no. 1  is  now positioned along the centroidal  axis  of  the  beam
array.

Additional editing should take place in a section view. To access a section view, select the entire beam series with the
 View... / Beam option and define the view plane from the first node to the last node in the global z direction.

  

Add tendon group 1 to the Visible tendon groups list.
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The tendon group is now displayed in the selected section. Next, use the Zero point option to move the position of
the reference system from the centroid to the upper edge of the section and then in the Base points  option select
Spline points.

If  the tendon group is  selected,  you can reposition it  by  first  clicking the existing spline  point  and  then  the  Spline
points  option. Only change the respective Zv position.  The Insert  option allows you to  add additional  spline points
before the active spline point.

Use this method to assign the desired geometry to the tendon group.

1 > < 1

0
0

Tendon groups in beam series Tendon view 1, [-16.00/0.00/0.00] - [112.00/0.00/0.00] / [-16.00/0.00/1.00]
Superelevation = 10

Tendon group ordinates zv [cm] at the base points

xv 0.00 6.40 12.80 19.20 25.60 32.00 38.40 44.80 51.20 57.60 64.00 70.40 76.80 83.20 89.60 96.00 102.40 108.80 115.20 121.60 128.00

1 70.0 52.0 19.2 42.0 120.2 180.1 208.8 201.5 157.4 78.3 18.5 78.3 157.4 201.5 208.8 180.1 120.2 42.0 19.2 52.0 70.0

In the tendon group view, the coordinates always refer to the reference system.
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Click the Representation option to activate the resulting prestressing force curve in the tendon group view:

Force function of tendon group 1 (4 tendon(s), l = 128.41 m)

Prestressing system 1 - EC2. Certification according to EC2.
Pm0      =  2295.0 kN,    Ap = 1800.0 mm², µa = 0.20, Angle  ß' =  0.30 °/m
E-Modulus= 195000 MN/m², Ah = 5281.0 mm², µn = 0.20, Slippage  =  6.00 mm

Prestressing procedure 1 - Example

Pre. anchor    :     Start       End
Normal. force  :     1.000     1.000
Pre. force [kN]:   2295.0   2295.0
Extension  [mm]:     694.5      72.8

8717.5 

xv

[m]0.00

8
3
3
7
.3

 [
kN

]

6.40

8
4
5
2
.6

12.80

8
5
8
4
.5

19.20

8
6
2
3
.2

25.60

8
5
0
6
.5

32.00

8
3
7
3
.7

38.40

8
2
2
9
.0

44.80

8
0
7
9
.4

51.20
7
9
3
6
.2

57.60

7
8
1
4
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64.00
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6
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70.40
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76.80
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83.20
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9
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89.60
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96.00
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3
7
3
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102.40
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5
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6
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108.80

8
6
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3
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115.20

8
5
8
4
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121.60

8
4
5
2
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128.00

8
3
3
7
.3

Loads and actions according to EN 1992-1-1

Enter the following loads:

Load case 1 Dead load (G1)

Load case 2 Additional loads11.06 kN/m (G2)

Load case 3 Snow load 7.90 kN/m (Q)

Load case 10 Prestressing (P)

Load case 15 Creep-generating continuous load: G1+P+G2
Load cases 1, 2 and 10 are grouped into this load case with the Insert load type.

Lastfall 20 Creep and shrinkage (CSR)

Coefficients: jt¥ = 2.55; r = 0.8; ecs.t¥ = -24.8 · 10-5 

The Creep and Shrinkage load type lets you calculate the redistribution of internal forces between the
concrete and prestressed steel. Specify load case 15 as a creep-generating continuous load case.

The following checks are carried out as a part of this example:

Checks in the Ultimate Limit
States

• Bending with or without
normal force or normal force
only

• Lateral force

• Minimum reinforcement
against failure without
warning

Checks in the Serviceability
Limit States

• Limiting the concrete
compressive stresses

• Limiting the reinforcing and
prestressing steel stresses

• Minimum reinforcement for
crack width limitation with 

fctm= 1; k = 1; x1= 0.27

• Crack with calculation
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The following input is required for these checks:

• Select and adjust the settings for the checks in the element properties

• Define the actions

To carry out the desired checks the following situations are necessary:

• Permanent and temporary 

• Rare (characteristic) 

• Frequent 

To take different (construction) stages into account, three situations are defined:

Construction stage: Dead load G and prestressing P (tendon not grouted)

t0: Dead load G, P, additional load and snow load (tendon grouted)

t¥: Dead load G, P, additional load, snow load and CSR (tendon grouted)

Calculation and results

Perform the following calculations after all system specifications have been made:

• Statics

• DIN EN 1992-1-1 Design

The  necessary  design  situations  are  used  for  all  checks  depending  on  the  requirement  class.  Each  situation  is  checked
independently and the maximum reinforcement for each steel layer is stored.
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A number of different calculation results are shown below:

Internal forces

-1
3
3
8
0

6
7
6
8

-1
6
8
7
1

6
7
7
2

-1
3
3
8
0

Value range (overall system, min/max): -16871.48/6771.54 [kNm]
Internal forces min,max My. 9885.63 [kNm] = 
LCC EN1992.SV.3: 3. Permanent and temporary situation, EN 1992-1-1, t8

-7
8
4
6

-7
4
4
4

-6
7
1
4

-7
4
2
6

-7
8
4
6

Value range (overall system, min/max): -7846.04/-6714.14 [kN]
Internal forces min,max Nx. 4597.29 [kN] = 
LCC EN1992.SV.3: 3. Permanent and temporary situation, EN 1992-1-1, t8

Longitudinal Reinforcement
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Value range (overall system, min/max): 0.00/89.82 [cm²], total weight from design: 5.5 t
Bending reinforcement, steel layer z >= zs; z < zs (dashed). 52.63 [cm²] = 
LCC EN1992.MIN: Robustness EN 1992-1-1
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Value range (overall system, min/max): 0.00/30.75 [cm²], total weight from design: 0.2 t
Bending reinforcement, steel layer z >= zs; z < zs (dashed). 18.02 [cm²] = 
LCC EN1992.RISS: Crack width limitation EN 1992-1-1

3
6

Value range (overall system, min/max): 0.00/36.22 [cm²], total weight from design: 0.1 t
Bending reinforcement, steel layer z >= zs; z < zs (dashed). 21.22 [cm²] = 
LCC EN1992.BRUCH: Ultimate limit state EN 1992-1-1
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Value range (overall system, min/max): 0.00/89.82 [cm²], total weight from design: 5.5 t
Bending reinforcement, steel layer z >= zs; z < zs (dashed). 52.63 [cm²] = 
LCC EN1992.MAX: Maximum EN 1992-1-1
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Shear reinforcement

1
0 5

1
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1
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Value range (overall system, min/max): 5.37/13.96 [cm²/m]
Stirrup reinforcement from lateral force Qz. 8.18 [cm²/m] = 
LCC EN1992.BRUCH: Ultimate limit state EN 1992-1-1

Concrete compressive stresses
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Value range (overall system, min/max): -16.88/2.69 [MN/m²]
Concrete compressive stresses min,max Sigma.x. 9.89 [MN/m²] = 
LCC EN1992.C: Maximum, Rare (characteristic) situation, EN 1992-1-1

Reinforcing steel stresses
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Value range (overall system, min/max): -99.50/43.29 [MN/m²]
Reinforcing steel stresses min,max Sigma.s. 58.30 [MN/m²] = 
LCC EN1992.C: Maximum, Rare (characteristic) situation, EN 1992-1-1

Prestressing steel stresses
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Value range (overall system, min/max): 936.03/1210.52 [MN/m²]
Prestressing steel stresses min,max Sigma.p. 709.29 [MN/m²] = 
LCC EN1992.C: Maximum, Rare (characteristic) situation, EN 1992-1-1
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Value range (overall system, min/max): 0.82/0.95 [-]
Prestressing steel stresses Sigma.p/Sigma.p,perm. 0.56 [-] = 
LCC EN1992.C: Maximum, Rare (characteristic) situation, EN 1992-1-1

Excerpt from the 'EN 1992-1-1 Design' log (short version)

Beam 17, Location 1

Design of longitudinal reinforcement

The calculated requ. reinforcement includes the specified basic reinforcement.

(M) Nominal reinf. for robustness as per EN 1992-2, 6.1 (109) (Charact. C.)
(R) Nominal/requ. reinforcement as per 7.3.2/4 for crack width limitation
    Increase of reinforcement due to crack width check is marked by "!".
    Ap'     Part of prestr. steel area Xi1*Ap which was used to reduce req.As
    Xi1     Bond coefficient for prestressing steel as per Eq. (7.5)
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Example 4: Prestressed Roof Girder

(B) Design of reinforement at ultimate limit state
    Results from a column design using the method with nominal curvatures
    according to 5.8.8 are marked with "+".
    In case of dominant bending, compression reinforcement is marked with "*".
    For section areas acc. to 6.1 (5) the conrecte strain is not limited.
    The minimum reinforcement acc. to 9.2.1.1 and 9.3.1.1 is not determined.
    For compressive members the minimum reinf. acc. to 9.5.2 is considered.
    whereby the prestressing steel area of bonded tendons is taken into account.

Beam             Reinforcement    Nx        My        Mz     Ap'   req.As
   No.  Se. Lo.  Lay. Type       [kN]     [kNm]     [kNm]   [cm²]   [cm²]
    17    1   1     1  M       109,56 -11704,67      0,00     .     44,91
                       R     -6042,73  -9624,61      0,00     .     15,38!
                       B     -6714,14 -16871,48      0,00     .     18,11
                    2  M       109,56 -11704,67      0,00     .     44,91
                       R     -6042,73  -9624,61      0,00     .     15,38!
                       B     -6714,14 -16871,48      0,00     .     18,11
                    3  M         0,06  -6609,23      0,00     .      0,00
                       R         0,00      0,00      0,00     .      0,00
                       B     -7555,93  -4040,19      0,00     .      0,00
                    4  M         0,06  -6609,23      0,00     .      0,00
                       R         0,00      0,00      0,00     .      0,00
                       B     -7555,93  -4040,19      0,00     .      0,00

Design of shear reinforcement

The percentage of nominal reinforcement acc. to Eq. (9.5N) is considered.

VRd, TRd  Design value of maximum absorbable lateral force, torsional moment
Angle     Angle cot Theta between the compressive strut and the beam axis
Asb,Asl.T Req. stirrup reinf. from lateral force and torsion, torsional reinf.
          Exceddings as per Eq. (6.12) are marked by "!" 
Asl       Req. longitudinal reinf. acc. to Fig. 6.3 for req. Asb.

Beam        Qy/         Asb.y   Qz/         Asb.z   Asl  Q/VRd+   Asb.T  Asl.T
   No. Loc. VRd   Angle[cm²/m]  VRd   Angle[cm²/m] [cm²] Mx/TRd  [cm²/m] [cm²]
    17  1  0,00   2,50   0,00  0,55   2,50  13,96    .     .        .      .

Check of crack widths

The check is led by direct calculation of the crack width.
The final long. reinforcement as the maximum from robustness, crack and bending
reinf. incl. a possible increase resulting from the fatigue check is decisive.

wk       Calculated value of crack width as per 7.3.4 [mm]
wmax     Permissible crack width as per specification [mm]
Sigma.c  Maximal concrete edge stress in state I [MN/m²]
         (CC) Charact. (rare), (TC) Frequent, (QC) Quasi-continuous combination

Beam               Reinf.    Nx      My       Mz    Sigma.x    wk    wmax
   No.  Se. C. Lo. Layer    [kN]    [kNm]    [kNm]  [MN/m²]   [mm]   [mm]
    17    1 TC  1     1 -6042,73 -9624,61     0,00     1,96   0,07   0,20

Check of concrete compressive stress

For the check, a cracked concrete section (II) is assumed if the tensile stress
from the decisive c. exceeds the value of fctm. Otherwise, a non-cracked section
(I) is used. If the strain is not absorbable on cracked section, (I*) is marked.

Sigma.x,min  Total maximal longitudinal compressive stress [MN/m²]
Sigma.x,per  = 0.60*fck for Charact. C. (CC) as per 7.2 (2)
(t,b)        Position of the edge point: above, below of centre

Beam             Sigma.x,min   Sigma.x,per  Se.-  Side   Period   Situation
   No.  Se. Loc.     [MN/m²]       [MN/m²]  Pnt.  t   b
    17    1   1  (I)  -16,88        -27,00     9  .   x  Final    CC.3

Check of steel stress

For the check, a cracked concrete section is assumed.
For tendon groups without bond and/or for situations before grouting,
the prestressing steel stress is checked acc. to Eq. (5.43).

Type S  Long. reinf. from N and M, layer number, Charact. C. (CC)
Type P  Prestressing steel, Tendon number, Charact. C. (CC)
Sigma.s,per = 0.80 * fyk resp. 1.0 * fyk (CK) as per 7.2 (5)
Sigma.p,per = 0.75 * fpk as per 7.2 (5)

Beam              Steel         As  Sigma.s      per.  Situation
   No.  Se. Lo. Type  No.    [cm²]  [MN/m²]   [MN/m²]
    17    1   1   S     1    44,91    43,29    400,00  CC.3
                  S     2    44,91    43,28    400,00  CC.3
                  S     3     0,00      .      400,00  CC.1
                  S     4     0,00      .      400,00  CC.1
                  P     1    72,00  1049,44   1275,00  CC.1
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